
RD003201-0415 
Overview

This document describes a Z8 Encore! XP-based LED flashlight controller reference 
design that employs the PWM block of Zilog’s Z8F082A MCU to control the power and 
functional modes of an LED flashlight.

Portable flashlights were early adopters of LEDs, and LED-based flashlights are now the 
most prevalent portable lighting solutions available on the market. However, many of 
these designs use simple resistor circuits that contribute to poor LED performance, 
decreased functionality, and diminished lifetimes.

The addition of an MCU to power and manage the LED provides opportunities for control 
of custom lighting patterns and sequencing, user interface control, and increased efficacy 
(in lumens per Watt) to result in longer battery life at greater lumen output. Additionally, 
an MCU implementation benefits from an application developer’s improved ability to 
modify or add functionality via a simple program update versus a hardware redesign.

The source code file associated with this reference design, RD0032-SC01.zip, is available 
free for download from the Zilog website. This source code has been tested with version 
5.2.0 of ZDS II for Z8 Encore! XP MCUs.

Features

The key features of this LED Flashlight Controller are:

• Z8F082A MCU with six I/O pins and 8 KB Flash

• In-system driver programming using a modified Zilog USB SmartCable

• Fast reprogramming from a hex or batch file to create a library of groups and modes

• 8x AMC7135 stackable pads (2800 mA)

• Open source for sharing and potential application improvement

• Low voltage detect is supported by the MCU (not implemented in the initial release)

• MCU temperature sensor is supported (not implemented in the initial release)

• Zilog Developer Studio IDE with C Compiler

• 17 mm diameter driver

• 4.5 KHz PWM

• 3 groups, multiple modes, and memory at ON time

• Low material cost

Note:
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Potential Applications

This reference design can be used to develop a number of applications; the brief list below 
offers a few ideas.

• LED Flashlight Driver Controller

• Alarm system LED controller

• Lighting LED controller

Discussion

This LED Flashlight Driver Controller reference design consists of a single printed circuit 
board (PCB) featuring Zilog’s Z8F082A MCU in an 8-pin SOIC package, plus resistors, 
AMC7135 current regulators, a diode, and a capacitor, as shown in Figure 1. 

The PCB is powered by a Lithium-ion battery (3.7 V to 4.2 V) through a battery spring and 
PCB ground ring. The PCB features four plated through-holes that provide easy access for 
in-system programming through the spring side of the driver. The 17 mm-diameter dimen-
sion of the PCB is suitable for most flashlights available in the market.

A schematic diagram of the LED Flashlight Driver Controller is shown in Appendix E. 
Schematic Diagram on page 22.

Figure 1. The LED Flashlight Driver Controller
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Principles of Operation

After battery voltage is applied to the PCB, the MCU will read the contents of Z8F082A 
Flash memory for group and mode data that was saved in a previous operation. If there is 
no valid code (i.e., this is the first time you are using the MCU), it will default to Group 1 
and Low Mode, as shown in Table 1 on page 3.

Controller Groups and Modes
Table 1 describes controller behavior. To provide an example, when in Group 1, and when 
the last operation before a power-off was ME (i.e., medium), the controller will turn the 
power on at ME. If power cycling is performed, as in the case of tapping the switch after a 
power-on, the controller will change the power to the next mode, which for Group 1 is a 
HI (i.e., high). Repeating these steps will cycle all modes within a group.

To change group, go to the designated change group level, as indicated in Table 1 by the 
modes displaying a green background. For example, Group 1 includes LO mode. After a 
power-on, or if going to this mode, wait for at least 1.2 seconds (your cue to wait is indi-
cated by a short blink), then perform a power cycle by tapping the power switch. The con-
troller will switch groups and will be at a specific mode for that group, as indicated by the 
red text/mode in Table 1 which, in the case of this driver, is in LO mode.

The levels for Moonlight (ML), Low (LO), Medium (ME), and High (HI) can easily be 
modified for the requirements of your application. Levels are expressed in decimal nota-
tion from 0 to 100, in which 0 = OFF and 100 = ON. Any numbers inside this range repre-
sent a percentage of a full ON (i.e., 100%).

Table 1. Groups and Modes Selection Guide

Group Selection by Short Tap After 1.2 s

Group 1 LO ME HI

Group 2 LO ME HI Blinker Police Strobe Pulse Beacon

Group 3 ML LO ME HI

Features/Options:
• Change the mode within 1.2 s by a a momentary press of the switch (i.e., a short tap).
• Change the group after 1.2 s at a designated mode within a group; the LED will blink.
• Red text: change the group location.
• Green box: the landing mode when changing a group.
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In Table 1, the following default timings and sequences are used for Group 2 functions: 
Blinker: 1.5 sec OFF→30  mS HI→and repeats
Police: 1.5 sec OFF→30 mS HI→60 mS OFF→30 mS HI→60 mS OFF→30 mS HI→and repeats
Strobe: 60 mS OFF→30 mS and repeats
Pulse: 50 mS HI→30 mS ME→30 mS LO→30 mS OFF→50 mS MH→30 mS LO→60 mS 6%→1 sec OFF and repeats
Beacon: 3 sec OFF→60 mS MH→30 mS OFF→60 mS→MH→30 mS OFF→60 mS MH and repeats.

Source Code
The source code is easy to understand and modify, and can be summarized as follows:

• Definitions

• Port setup

• PWM setup (4.5 KHz)

• Timer setup

• Read previous Group and Mode

• Turn on the LED using Group and Mode info

• Check for Mode and Group change

• Save Group and Mode

Setup, Configuration and Use

This section describes how to set up, configure, and operate this reference design. The 
LED Flashlight Driver Controller is shipped with the code preprogrammed and ready to 
use.

Flashlight LED Driver Controller Procedure for a P60 Pill
1. Solder the red and black wires to the LED while observing the correct polarity, as indi-

cated in Figure 2.

Note:
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2. Apply thermal grease between the LED sink pad and the P60 pill for better heat trans-
fer.

3. Secure the LED Flashlight Driver Controller PCB to the P60 pill.

4. Assemble the Flashlight and insert a fully charged 3.7 V–4.2 V Lithium-ion battery. 
For optimal battery contact, Zilog recommends slightly crimping the upper end of the 
battery spring towards the middle, as indicated in Figure 3.

5. Turn the flashlight on and operate it as described in the Controller Groups and Modes 
section on page 3.

Figure 2. P60 Pill, LED, and LED Flashlight Driver Controller

Figure 3. Spring, Top View
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This reference design is recommended for use on flashlights with a switch turn ON resis-
tance of lower than 0.30 Ω.

Viewing and Compiling the Source Code
To view and recompile the source code for this reference design, observe the following 
procedure:

1. If you have not already done so, download the software for this reference design. In a 
web browser, visit the Zilog website and navigate via the Applications menu to Refer-
ence Designs → LED Controllers → LED Flashlight Driver Controller. In the list 
of Associated Documentation, right-click to download the source code for the LED 
Flashlight Driver Controller; the code and all documentation are contained in a zip file 
labeled RD0032-SC01.

2. When the download is complete, unzip the file to your hard drive, double-click to 
launch the installation file named ZRD00320100ZRD_1.0.exe, and follow the on-
screen instructions.

3. Navigate to the following directory to install ZDSII_Z8Encore! 5.2.0:

C:\Program Files (x86)\Zilog\ZRD00320100ZRD_1.0

Launch the zds2_Z8Encore!_<version_build>.exe file and follow the on-
screen instructions.

4. An option to launch ZDS II is presented at the completion of the ZDS II installation 
prior to exiting; select this option to immediately run ZDS II. As an alternative, launch 
ZDS II by navigating via the following default path:

Start → Programs → Zilog ZDS II_Z8Encore!_<version_number> → 
ZDSII_Z8Encore!<version_number>

5. From the File menu in ZDS II, select Open Project to display the Open dialog box.

6. Browse to the src folder which, by default, is located in the following path:

C:\Program Files (x86)\ZiLOG\ZRD00320100ZRD_1.0\src

7. Select the ZRD00320100ZRD_1.0.zdsproj file from the src folder and click Open 
to display the initial ZDS II program screens. To view the source file, double-click the 
Project Files folder on the left side of the ZDS II interface. Double-click the 
ZRD00320100ZRD_1.0 file to open the file in the ZDS II file editor.

8. Click the Rebuild All toolbar icon, which is highlighted in red, in Figure 4.

Note:
RD003201-0415  Page 6 of 23

http://www.zilog.com/docs/referencedesign/RD0032-SC01.zip


LED Flashlight Controller/Driver Using a Z8 Encore! XP MCU
Reference Design
9. When the rebuild is complete, a Build succeeded message will appear in the Out-
put window’s Build tab, as highlighted in Figure 5.

Figure 4. IDE Project Rebuild All
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The output checksum in Figure 5 is for reference only and may not display the same result 
as at the time of publication.

Reprogramming the LED Flashlight Driver Controller Using a 
Batch File

This section presents the materials and procedures required to reprogram the LED Flash-
light Driver Controller.

Required Materials

One USB SmartCable, Zilog part number ZUSBSC0100ZACG

Procedure

Observe the following procedure to reprogram the controller. The first three steps in this 
procedure only need to be performed once.

1. Perform the USB SmartCable Programming pin modification described in Appendix 
B. on page 15.

2. Install the USB SmartCable Driver as described in Appendix C. on page 18.

3. Perform the USB SmartCable serial number procedure described in Appendix D. on 
page 19.

4. Disconnect the 6-ckt cable from the USB SmartCable to ensure that the driver is not 
powered up when connecting the programming pins; see Figure 6.

Figure 5. IDE Project Build Succeeded

Note:
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5. Connect the four programming pins to the LED driver, as shown in Figure 7.

6. Navigate to the following directory:

C:\Program Files (x86)\Zilog\ZRD00320100ZRD_1.0\src

7. Connect the 6-circuit cable to the USB SmartCable; see Figure 8.

Figure 6. USB SmartCable Module and 6-Circuit Cable

Figure 7. USB SmartCable and LED Flashlight Driver Controller
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8. Hold the programming pins at enough of an angle to secure the contact to the driver.

9. Double-click the ZRD00320100ZRD_1.0.bat file to launch the ZDS II IDE and run 
a DOS batch file, which will program the MCU. When completed, this batch file will 
close ZDS II and all DOS windows.

10. Open and view the generated ZRD00320100ZRD_1.0.log file to ensure that you see 
a message similar to the following message.

==================================================================
option linker exeform = "OMF695,Intel32"
flash options "ZRD00320100ZRD.hex"
flash options EBF
flash burnverify
Connected to target TZF082A
Successfully initialized target.
Target connection closed
Internal flash erase complete.
File flashed with verification: ZRD00320100ZRD.hex
Flash File Checksum::0xACF2
Flashing complete.
wait 100
close project

Different code will cause the Flash File Checksum result to appear different from the 
result shown above.

Figure 8. Completed USB SmartCable Assembly

Note:
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Programming the LED Flashlight Driver Controller with a New 
Code/Hex File

Observe the following procedure to program the controller with a new code/hex file. 

1. Create a copy of your hex file and save the new file as ZRD00320100ZRD.hex.

2. Return to Step 4 of the previous section and follow the remainder of that procedure.

Programming the LED Flashlight LED Driver Controller Using 
ZDS II

Observe the following procedure to program the controller using Zilog Developer Studio 
(ZDS II). 

1. Open the project. For assistance, see the Viewing and Compiling the Source Code sec-
tion on page 6.

2. Assuming you have already performed the hardware and software installations in pre-
vious sections, program the LED Flash Driver Controller by clicking the Download 
Code toolbar icon ( ).

3. You may see a message similar to the message shown in Figure 9. Click the OK button 
to continue. 

4. A successful programming of the controller will present a message similar to the mes-
sage shown in Figure 10.

Figure 9. ZDS II Silicon Warning Message
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Software and Documentation

Upon installation, the software and documentation that support this reference design will 
be located in the following installation directories:

ZDS II – Z8Encore! 5.2.0

C:\Program Files (x86)\ZiLOG\ZDSII_Z8Encore!_5.2.0

ZRD00320100ZRD 1.0

C:\Program Files (x86)\ZiLOG\ZRD00320100ZRD_1.0

All documents associated with the LED Flashlight Driver Controller Reference Design are 
listed in Table 2. Each of these documents can be obtained from the Zilog website by 
clicking the link associated with its Document Number.

Ordering Information

The products associated with this LED Flashlight Driver Controller Reference Design can 
be ordered from the Zilog Store using the Part Numbers listed in Table 3.

Figure 10. ZDS II Silicon Success Message

Table 2. LED Flashlight Driver Controller Documentation

Document 
Number Description

RD0032 This LED Flashlight Driver Controller Reference Design document

PS0228 Z8 Encore! XP F082A Series Product Specification

UM0181 USB SmartCable User Manual

Table 3. Ordering Information

Part Number Description Store Product ID

ZRD00320100ZRD LED Flashlight Driver Controller Reference Design RD10036

ZUSBSC0100ZACG USB SmartCable RD10023
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Kit Contents

The LED Flashlight Driver Controller Reference Design contains the following item:

• One (1) LED Flashlight Driver Controller

Results

This LED Flashlight Controller/Driver reference design was designed and tested using an 
Ultrafire 502B Flashlight as discussed in this document and performed as expected.

Summary

This low-cost reference design demonstrates an LED Flashlight Controller/Driver consist-
ing of a Z8F082A MCU and current regulators. The PWM provides the necessary signal 
to control the brightness of the LED, while the MCU’s Flash memory stores the previous 
mode of operation.

This very simple design and can be used to control other LED applications.
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Appendix A. Bill of Materials

Table 4 lists all parts that comprise the LED Flashlight Driver Controller Reference 
Design.

Table 4. ZRD00320100ZRD Parts List

Part Quantity

PCB-99C1408-001G 1

Diode: 1N4148WS 1

Cap: 1 µF 1

Resistor: 10 KΩ 2

Spring 1

AMC7135 8

Z8F082A MCU 1
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Appendix B. USB SmartCable/Programming Pin Modification

This appendix presents the materials and procedures required to modify the USB Smart-
Cable for programming the LED Flashlight Driver Controller. The purpose of this modifi-
cation is twofold: to modify VCC for applying the appropriate power to the LED driver 
when programming, and to modify one end of the 6-circuit cable for LED driver program-
ming.

Required Materials

• One Programming Cable, Zilog part number ZUSBSC000100ZACG;1 see Figure 11.

• Soldering iron and solder

Procedure

Observe the following procedure to modify the USB SmartCable.

1. Open the USB SmartCable casing by unscrewing the two Phillips screws. 

2. Solder a connecting wire between the two points shown in Figure 12. In essence, con-
nect the wire from the Blue connector to Pin #1, which is identified on the PCB by a 
small silkscreened square.

1. The Programming Cable is available from both Digikey and Mouser.

Figure 11. Programming Cable Shown with USB SmartCable Attached
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3. With Figure 13 as your guide, modify one end of the 6-circuit cable for LED driver 
programming, as follows:

a. Cut one end of the cable near the connector (or in the middle to build two shorter 
versions).

b. Solder the four wires to the following pins, as follows:

○ Pin #1: VCC (starting from the red stripe end)

○ Pin #2: RST

○ Pin #3: GND

○ Pin #4: DBG

Figure 12. Solder Connections for Modifying the USB SmartCable

Figure 13. 6-Circuit Cable Modified for Programming
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c. Trim to remove lines #5 and #6.

The PCB is optional. It is the same PCB as the driver PCB, and is used to guide/align the 
pins during programming. To prevent accidental shorting, place a Kapton or insulating 
tape at the bottom (i.e., pin) side of the PCB when programming the driver.

4. Connect the other end of the 6-circuit ribbon cable to the USB SmartCable unit, ensur-
ing that the ribbon’s male connector is aligned correctly with the female connector on 
the unit.

5. Install the USB SmartCable driver – see Appendix C. Installing the USB SmartCable 
Driver on page 18.

Note:
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Appendix C. Installing the USB SmartCable Driver

Observe the following procedure to install the USB SmartCable on a Windows 7 system.

1. Connect the USB SmartCable to a USB port on your development PC. When the PC 
detects the new hardware, it will display the Installing device driver software dialog.

2. Windows automatically searches for the driver; this process can take a few moments. 
Because there is no option to terminate this search process, wait for the search to com-
plete. If the driver was previously installed, Windows will automatically install the 
USB SmartCable driver. If this is the case, skip ahead to Step 9. If Windows cannot 
find the driver, close the search dialog and proceed to the next step.

3. In the Search programs and files field in the Windows Start menu, enter Device Man-
ager. The Device Manager will appear in a list of search results.

4. From this list of results, click Device Manager to open the Device Manager dialog, 
which presents a list of devices that operate on your PC. Find and toggle Other devices 
to view a sub list of additional devices, and right-click your mouse on USB SmartCa-
ble.

5. In the submenu that appears, click Update Driver Software....

6. In the Update Driver Software – USB SmartCable dialog that appears, click the 
Browse my computer for driver software option.

7. Click the Browse... button to browse to one of the following driver directories, 
depending on the configuration of your PC.

On 32-bit Windows 7 systems, navigate to:

<ZDS II Installation Directory>\device drivers\USB\x32
<ZDS II Installation CD>\device drivers\USB\x32

On 64-bit Windows 7 systems, navigate to:

<ZDS II Installation Directory>\device drivers\USB\x64
<ZDS II Installation CD>\device drivers\USB\x64

8. Click Next to install the driver. On 32-bit Windows systems, a security dialog will 
appear; select Install this driver software anyway.

9. After the Wizard finishes the installation, click Close.
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Appendix D. USB SmartCable Serial Number

Observe the following procedure to determine the unique serial number that identifies 
your USB SmartCable.

1. Launch ZDS II - Z8 Encore! 5.2.0 via the Windows Start menu, and navigate to Zilog 
ZDS II > Z8 Encore! 5.2.0 > ZDS II – Z8Encore! 5.2.0.

2. From the File menu in ZDS II, choose Open Project and navigate the following path:

C:\Program Files (x86)\ZiLOG\ZRD00320100ZRD_1.0\src

3. Select the ZRD00320100ZRD_1.0.zdsproj project file and click Open; see Figure 
14.

4. From the Project menu in ZDS II, choose Settings. Click Debugger in the left panel 
and, in the Debug Tool panel, select USBSmartCable from the Current: menu, as 
shown in Figure 16.

Figure 14. Select a Project File from the Open Project Dialog
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5. Click the Setup button in the Project Settings dialog. The Setup USB Communication 
window appears, as shown in Figure 16.

Figure 15. The ZDS II Project Settings Dialog
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6. The serial number assigned to your USB SmartCable unit will be different than the 
serial number shown in Figure 16. Write this serial number down; you will need it in 
Step 11. Click OK.

7. Click OK a second time to exit the Project Settings dialog box.

8. From the File menu in ZDS II, choose Exit to close the program.

9. Launch Notepad or similar text editor, then navigate via the following path to open the 
ZRD00320100ZRD_1.0.txt file:

C:\Program Files (x86)\ZiLOG\ZRD00320100ZRD_1.0\src\
ZRD00320100ZRD_1.0.txt

10. Locate the following line in the ZRD00320100ZRD_1.0.txt file:

debugtool set "usbSerialNumber" "000000"

11. Replace the null serial number, 000000, with the serial number you wrote down in 
Step 6; for example:

debugtool set "usbSerialNumber" "101202-0018"

12. Save the file.

Figure 16. The Setup USB Communication Dialog
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ndix E. Schematic Diagram

Figure 17 displays a schematic diagram of the LED Flashlight Driver Controller.

Figure 17. Schematic Diagram of the LED Flash Driver Controller
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Customer Support

To share comments, get your technical questions answered, or report issues you may be 
experiencing with our products, please visit Zilog’s Technical Support page at 
http://support.zilog.com.

To learn more about this product, find additional documentation, or to discover other fac-
ets about Zilog product offerings, please visit the Zilog Knowledge Base at http://
zilog.com/kb or consider participating in the Zilog Forum at http://zilog.com/forum.

This publication is subject to replacement by a later edition. To determine whether a later 
edition exists, please visit the Zilog website at http://www.zilog.com.

DO NOT USE THIS PRODUCT IN LIFE SUPPORT SYSTEMS.

LIFE SUPPORT POLICY

ZILOG’S PRODUCTS ARE NOT AUTHORIZED FOR USE AS CRITICAL COMPONENTS IN LIFE 
SUPPORT DEVICES OR SYSTEMS WITHOUT THE EXPRESS PRIOR WRITTEN APPROVAL OF 
THE PRESIDENT AND GENERAL COUNSEL OF ZILOG CORPORATION. 

As used herein

Life support devices or systems are devices which (a) are intended for surgical implant into the body, or (b) 
support or sustain life and whose failure to perform when properly used in accordance with instructions for 
use provided in the labeling can be reasonably expected to result in a significant injury to the user. A 
critical component is any component in a life support device or system whose failure to perform can be 
reasonably expected to cause the failure of the life support device or system or to affect its safety or 
effectiveness.

Document Disclaimer

©2015 Zilog, Inc. All rights reserved. Information in this publication concerning the devices, applications, 
or technology described is intended to suggest possible uses and may be superseded. ZILOG, INC. DOES 
NOT ASSUME LIABILITY FOR OR PROVIDE A REPRESENTATION OF ACCURACY OF THE 
INFORMATION, DEVICES, OR TECHNOLOGY DESCRIBED IN THIS DOCUMENT. ZILOG ALSO 
DOES NOT ASSUME LIABILITY FOR INTELLECTUAL PROPERTY INFRINGEMENT RELATED 
IN ANY MANNER TO USE OF INFORMATION, DEVICES, OR TECHNOLOGY DESCRIBED 
HEREIN OR OTHERWISE. The information contained within this document has been verified according 
to the general principles of electrical and mechanical engineering. 

Z8, Z8 Encore! and Z8 Encore! XP are trademarks or registered trademarks of Zilog, Inc. All other product 
or service names are the property of their respective owners.

Warning:
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